Miért kell Iépc$zetesen végezni az elemzést, miert
nem lehet egyetlen ANOVA-tablazatbdl donteni?

Minden lépésnél Uj vizsgalatot kezdtlink, Uj ANOVablazatot
szamoltunk, és csak egy dsszehasonlitast haszkialtun
Id. kdlén lapon

Az egymas utan kovetkézizsgalatok Error négyzetdsszege és
szabadsagi foka névekszik.

A Time négyzetdsszege és szabadsagi foka véaltazatla

A Batchn négyzettsszege és szabadsagi foka kildabozi
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Az alapértelmezett négyzetdsszeg-tipus: ,Effectiysothesis
decomposition”
A vélaszték:

% GL.M Homogeneity-of-Slopes: Lin1.sta

EE Random factors: | none Cancel
Sumgz of sguares .
Sweep delta: 1.E- |?_|§| E Options  +

" Type | [zequential]
Inverze delta: 1.E- EE € Type l [partial]

Parameterization ™ Type Il [orthogonal]
¥ Sigma-restricted fe

[~ Nointercept O Type W [full-rank)
I Lack of fi ' Type vl [unique)

Cross-validatior: | off
[EE Ciossvalidation: | o B? Surtax edior
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Type VI: Hy: a vizsgalt hatas modellbe vétele nem javitja a
leirdst (nem csokkenti szignifikAnsan a maradék
négyzetosszeget), feltéve, hogy az 6sszes tadplonéa
benne van a modellben.

Type | (szekvencialis)

a modellt a tagok egyenkénti bevonasaval épitjlik fo

H,: a vizsgalt hatas modellbe vétele nem javitjdrade,
feltéve, hogy a folotte Iék mar benne vannak a modellben

Id. a kilén lapon

Yiik :ﬁ+(ai _ﬁ)+ﬁxij +(:8| _IE)XH &
t ! AN
Intercept Batchn Time Batchn*Time
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Type | esetén

Az egyes hatasokhoz tartozé négyzetdsszegek azgmusak
valtoznak, ha lépézetesen tovabbi tagokat veszink a modellba.
Ha elhagyunk tagokat a modédilpbazok négyzetdsszege és
szabadsagi foka az Error tagba kertdil.

Az F, probastatisztika értéke a megféledgokra nem pontosan
azonos az egyes elemzéseknél, mert az Error néggzetp mas.

Az egyes elemzési lépésekben vizsgélt hatdsokranagy az
eredményt kapjukHy-ra ésp-re), mint a szimultan (Type VI.)
vizsgalatnal, ha csak a kérdéses sort nézzik.

A legel$ (a Homogeneity-of-slopes elemzésnél kapott)
ANOVA-tablazatbdl az 6sszes dontéseket meghozhatpek
csak kétségep£0.05) esetben finomitandok.
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Univariate Results for Each DV (Linl.sta)
Sigma-restricted parameterization
Type | decomposition
Degr. of | Concent | Concent | Concent | Concent
Effect Freedom SS MS F p
Intercept 1| 208801.71 208801.71 103384.76 | 0.000000
Time 1] 11.70 11.70 5.80  0.029401
Batchn 2 1.14 0.57 0.28 0.757503
Batchn*Time 2 1.14 0.57 0.28 0.757352
Error 15 30.29 2.02
Total 20 44.29 Univariate Results for Each DV (Lin1.sta)
Sigma-restricted parameterization
Type | decomposition
Degr. of | Concent Concent Concent | Concent
Effect Freedom SS MS F p
Intercept 1 208801.71 | 208801.71  112906.92| 0.000000
Time 1 11.70 11.70 6.33| 0.022220
Batchn 2 1.14 0.57 0.31 0.738223
Error 17 31.44 1.85
Univariate Results for Each DV (| Total 20 44.29
Sigma-restricted parameterization
Type | decomposition
Degr. of | Concent ‘ Concent ‘ Concent ‘Concent
Effect Freedom SS MS F p
Intercept 1 208801.71 | 208801.71 121763.72  0.000000
Time 1 11.70 11.70 6.83/ 0.017120
Error 19 32.58 1.71
Total 201 44.29
Stabilitasvizsgalat 50
3. példa: A sarzsok egyesithségének vizsgélata
Lin2_MD.sta
Time |Batchl| Batchd Batch3  nem kiegyensulyozott ter|
(month)
0 105.4 101.8 | 105.1
4 104.5
8 103.6
13 104.9
26 106.3
39 102.8 99.9
52 103.1 101 104.5
78 102.8 99.2 103.7
104 102.2 99.1

Stabilitasvizsgalat
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Specify Multiple Subsets

7
Subsel 1 - Batchn=2 a legalso
Inchude If: i
Cancel
Btchn |
Subsat 2 Scatterplot of Concentr against Time
B Lin2_MD.sta 3v*17¢c
Inchude [f: v 107
Batchn=2 .
106
%
Subset 3 105 PY o
Include If: v ° °
104
Batchn=3 ° .
£ 103 <
g
Subset 4 g < o
5 o
Include I~ o 102 a
101 o
v
100 n
99 “ a
98 < Include Batchn=1
o =,
-20 0 20 40 60 80 100 120 ° Include Batchn=2
® Include Batchn=3
Time O Other
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Statistics>Advanced Linear/Nonlinear Models>Genknaéar Models>
Homogeneity of slopes

Univariate Tests of Significance for Concentr (Lin2.sta) Optlons fUIon' Type I
Sigma-restricted parameterization Quick falon: All effects
Type | decomposition
SS Degr. of MS F p
Effect Freedom
Intercept 180126.471 1/ 180126.47 273518.9 0.000000
Time 25.346 1 25.35 38.5| 0.000067 P A
Batchn 41.649 2 20.82 31,@ L Dontées?
Batchn*Time 1.140 2 0.57 0.9 0.447651
Error 7.244 ‘\1‘1\0.66

/ S -SS,

$D=;;(Yij_ai_lgixij) Ssc:ii(yij_di_:éxij)z

i=1 j=1
r J r

Vo= (n-2) ve=>(n-1)-1

i=1 i=
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Statistics>Advanced Linear/Nonlinear Mo
Models>General Linear Model

EE GLM Between Effects: Lin2_MD.sta

ok

Cancel

To build custom effects to be included in the between design, select predictor variables for the
effects and a method for building the effects.

() Use default effects for the between design

() Use custom effects for the between design

Fredictor variables Method Effects in between design
Categorical: Batchn 1
il £ 1
Time
Batchn*Time
Full factorial
Continuous:
Clear all

Degree: |2 @

To reorder 'Effects in between design,’ select line(s)to mowe and click between lines of new

Ho effect selected

Stabilitasvizsgalat

dels>Genkinadar

Iethod
(add ]

Effects in betweer

Batchn*Time

Megvaltoztatjuk a tagok
sorrendjét

54

Statistics>Advanced Linear/Nonlinear Mod
Analysis of Covariance

els>Genkma¢ar Models>

Quick fulon: All effectg

Dontés?

Univariate Tests of Significance for Concentr (Lin2.sta)
Sigma-restricted parameterization
Type | decomposition
SS Degr. of MS F p
Effect Freedom
Intercept | 180126.471 1 180126.47 279300.9 0.000000
Time 25.346 1 25.35 39.3/ 0. 9
Batchn 41.649 2 20.82 32.3(0.000008
Error 8.384 \ﬁ\ 0.64
SS. =SS, +(SS. - SS,)
r n;
5= 2.0y
i=1 j=1

Stabilitasvizsgalat
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Az adatok részben egyesithiket{parhuzamos egyenesek: C
modell).

El6nye: a degradalddasi egyenes meredekségét todimhdat
pontosabban becsulveigebb konfidencia-savot, s igy
hosszabb becsiilt eltarthatdsaditidapunk.

Ellenérizzik a modell alkalmassagat a reziduumok
abrazolasaval!
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Raw Residuals

-0.5

-1.0

-1.5

-2.0

2.0

Predicted vs. Residual Values
Dependent variable: Concentr
(Analy sis sample)

15

1.0

0.5

0.0

Normal Prob. Plot; Raw Residuals
Dependent variable: Concentr
(Analysis sample)

98

99 100 101 102 103 104

=
o
@

Predicted Values

Expected Normal Value

-3.0
-2.0 -1.5 -1.0 -0.5 0.0 0.5 1.0 15 2.0

Residual
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Kdz6s meredekség, egyedi tengelymetszet:

minden sarzsra kulon-kilon ki kell szamitani azréit@osagi
Id6t, a legrovidebb lesz az 0sszes sarzsra elfogadostit
eltarthatéséagi idl

95%-0s egyoldali (90%-os kétoldali) konfidenca-sdegalul futd
egyenesre

Statistics>Advanced Linear/Nonlinear Models>Genknaéar
Models>Analysis of Covariance

Dependent: Concent

Categorical pred.: Batchn

Continuous pred.: Time
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Summary fulén: Confidence 0.9
Resids fulon: a Predicted and residuals gomb melstended
stats négyzetbe tegyunk pipat, és kattintsunk a Gawdra.

L GLM Results 1: Lin2_mp.sta R

Select variables to save along with t

Quick. ] Summary ] Means ] Comps ]
Profiler Resids l b atrix ] Report ]
{+ i i i

E Dep. variables | Concentr

Shaow predicted and regidual valu

Plate nf mredicted amnd racidoal walies

Stabilitasvizsgalat 59




| ! !

Lin2_MD.sta
1 ‘ 2 ‘ 3 ‘ 4 ‘ 5 ‘ 6 ‘ 7 ‘ 8 ‘ 9 ‘ 10
Time Batchn | Concentr | ConcOBS1 | ConcPRE1 | ConcRES1 | ConcSEP1 | ConcLPI1 | ConcUPI1 | ConcLCL1
| 0.000 1.000 105.400 105.400 104.450 0.950 0.489 102.418 106.482 103.394
| | 39.000 1.000 102.800 102.800 103.600 -0.800 0.371 101.689 105.512 102.798
| | 52.000 1.000 103.100 103.100 103.317 -0.217 0.359 101.416 105.218 102.540
| | 78.000 1.000 102.800 102.800 102.750 0.050 0.386 100.825 104.675 101.915
| | 104.000 1.000 102.200 102.200 102.183 0.017 0.468 100.175 104.191 101.172
| 0.000 2.000 101.800 101.800 101.390 0.410 0.489 99.359 103.422 100.334]
|| 39.000 2.000 99.900 99.900 100.540 -0.640 0.371 98.629 102.452 99.738
| | 52.000 2.000 101.000 101.000 100.257 0.743 0.359 98.356 102.158 99.480
| | 78.000 2.000 99.200 99.200 99.690 -0.490 0.386 97.765 101.615 98.855
104.000 2.000 99.100 99.100 99.123 -0.023 0.468 97.115 101.131 98.112
| 0.000 3.000 105.100 105.100 105.221 -0.121 0.342 103.335 107.106 104.483
| 4.000 3.000 104.500 104.500 105.134 -0.634 0.331 103.257 107.010 104.418
8.000 3.000 103.600 103.600 105.046 -1.446 0.322 103.177 106.916 104.350
|| 13.000 3.000 104.900 104.900 104.937 -0.037 0.313 103.075 106.800 104.260
|| 26.000 3.000 106.300 106.300 104.654 1.646 0.304 102.799 106.509 103.998
|| 52.000 3.000 104.500 104.500 104.087 0.413 0.343 102.201 105.973 103.347|
78.000 3.000 103.700 103.700 103.520 0.180 0.439 101.543 105.497 102.572,

Data>Input Spreadsheet Time, Batchn, ConcPRE1, ConcLCL1
Scatterplot
Sel>Batchn=2
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Data>Input Spreadsheet 2D Scatterplots
Scattel’p|0t Quick ]Advanced] Appearance | Catec
Sel>Batchn=2
Scatterplot of multiple variables against Time . .
Spreadsheetl 21v*17c E & i
Include condition: Batchn=2 E_ M ConcPRET ConcLCL1
102.0
1oLs 9 Graph type: Fegression band
101.0 " arf
(™ Confidence
100.5 o
o o " Prediction
100.0 ]
o ° Fit type:
99.5 = [ Linear
99.0 ©
[m}
98.5
98.0 °
075 jobb click:
-20 0 20 40 60 80 100 120 .
Time 5 ConeloLy Graph Properties
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: 73
oo _____ O

Graph Window | J | J .................................................
————————— Plat:|1: ConcPRE1 | Fit |1 - i Addnewfit i Fit bype: Spline

Graph Layout wP Cpiin

Graph Titles/Text Fit type: | |4 Linear j Delate Fitting data

Plat: General Fitting data Scale: |# hd

Plat; Scatterplot X
T SeAEP el ¥ % Range: |Full Range +| M [0
Plat: Paint Labels

— Range: |Full Range - Mir: M Line
Flot: Fitting
! "hreadsheet3s /v1/c v Pattern...  —— | Resalutia

ConcPRE1 = 101.3904-0.0218*x
ConcLCL1 = Spline

Include condition: Batchn=2

e jobb click:
e Graph Properties

101.0

100.5

100.0

99.5

99.0

98.0
20 0 20 40 60 80 100 120 :Z: gg:gfgil

Time
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Extrapolacié

1. Egészitsuk ki az adatfile-t azokkal agpdntokkal, amelyekre
szamitast kivanunk végezni: 120, 160 és 2066dggseg.
Ezekben az ighontokban nincs koncentracié-mérési adatunk, tehg
megfeleb cellak tresen maradnak.

Lin2pred.sta

Tme | Baum | comeny | 2. Hajtsuk végre a kovariancia-analizist
; 2 1 1054 3, Szamitsuk ki a becsult koncentracio-
5 8 1 ertékeket (az illesztett egyenes pontjait)
4 13 1 és az also konfidencia-sav pontjait
5 26 1
6 39 1 102.8 .
7 52 1 1031 Confidence 0.9
8 78 1 102.8
9 104 1 102.2
10 120 1
11 160 1
12 200 1
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Summary Means Planned comps Pozt-hoc Azsumptions Su mmary fU|On CO nfldence 0 9
Fesidualz 2 | Matrix | Feport More results

Sample . vep e
Congefi © foes Residuals1 fulén:

Iz

Extended
v E
stats

Profiler || Customn tests

Show predicted and residual +A

B Predicted and residuals

O Predi

Select variables to save along with t

Summary Means Planned comps Post-hoc Azzumptions
Profiler | Customtests Besiduals 1 Residuals 2 | Matis | Repo

@ Dependent variables | Copcentr

Show predicted and residual fralues

! : Extended
[m Fredicted and resu:lgals\l stats
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Egyesitjik a két Spreadsheet-et.
Data>Merge

Hagyjuk el a folosleges oszlopoK

Wariables l% Text Lahels} Easesl = Dptinns}

Mode Unmatched Cases

(" Concatenate % Fill with MD

™ Cartesian " Delete cases

" Match casenames " Generate Cartesian

" Abort merge

% Malch vanables

Multiple Cazes

Match Criteria * Fillwith M0 I Crop File 1 multiples

By &uto - " Coppdown | Diop File 2 mulkiples
Fie1.. | [Spreadshestz0 \

] |Spraadsheet21

Hot&~when you click the 0K button, the

will be the Ty OK Cancel
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102

Scatterplot of multiple variables against Time
Spreadsheet8 4v*36¢
Include condition: Batchn=2

101 Q

100

99

98

97

96

95

94

40 60 80 100 120 140 160 180 200 220 6 ConcPREL

Time O ConcLCL1
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ALl Options

Graph 'Window
Graph Layout

Flat: General
Flat: Scatterplot
Plat: Paint Labels
Flot: Fitting

101
100
99
98
97
96

95

94

Graph Titles/Text

Plot: | 2 ConeLCLY ~ Rt~

Plat [1:ConcPRET =] Fit[1 =] Fit type:
Fit tupe: ||4Linear j Delate Fitting data
Fitting data Scale: |# -

Seale: |% < Range: |Full Range +| M [0
Range: |Full Range - Min: Man: © Line

05 v Pattern... —| Rezolutio

40 60 80 100 120 140 160 180 200 220
o ConcPREL

Time . ConcLCL1
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Ha egy-egy iéipontban tobb adatunk van, azokra szamoljunk, vagy
az atlagaikra?

Scatterplot of Y against X
Linreg2.sta 2v*25¢c
Y = 0.7375+2.1164*x; 0.95 Conf.Int.

atterplot of Y against X
escriptive Statistics (Linreg2.sta) 2v*5¢
375+2.1164*x; 0.95 Conf.Int.

04 06 08 10 12 14 16 18 20 22 24 26 28 30 32

1
04 06 08 10 12 14 16 18 20 22 24 26 28 30 32

X

X
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Nem minden papsajt!

A mérési pontok rendellenes elhelyezkedése

Az idépontok kozotti ingadozas figyelembe vétele
Nemlineéris figgvény

Rész-tervek (matrixing €s bracketing)

Koncepcionalis probléma
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Az idépontok kozotti ingadozas figyelembe vétele
T.E. Norwood, Drug Development and Industrial Phesyn 12 (1986) 553-560

Assay content (%)

o "A"batch & "B"batch 0O "C"batch

103

102

101

100

99

98

97

96

95

94

o
o
o 5§
o 5
2} =
a o
a o
O o
o A
o o
9 &)
9 o
q =
u}
= o
= o
8
=
O
0 3 6 9 12
Months
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Korrekciés leheiség, ha a sarzsok nem egyszerre indul

hénap tarolasi id (j)
naptari {) "A" sarzs "B" sarzs "C" sarzs
0 0
3 3 0
9 9 6 3
12 12 9 6
18 18 15 12
24 24 21 18
=a, + BX; helyett Y, =a, +Bx;+4,

t a naptari id

K. Komka, S. Kemény: A modified error model for thesessment of stability
of pharmaceutical products, Chemometrics and Igtsili Laboratory Systems,

72, 161-165 (2004)
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Nemlinearis degradalédasi fuggveny illesztése

Szerencseés esetben talalunk a figgetlen valtoiyaa o
transzformaciot, amelyre a figgaltozo linearis lesz.

4. példa
9 sarzs koncentraciéjanalkoiokeli valtozasara vannak adatain
minden idpontban egy mintaval

nemlin_stab.sta
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Graphs>Scatterplots
Advanced fulén Mark selected subsets

Scatterplot of konc against ho
nemlin_stab.sta 3v45¢c

102 T
100 %
A
" +
o " .
98 + & .
n
2 : .
96 -
5 [
L] *
% . ® ° ¥
2 & b4
g 4 - i
92 +
A
90 + <
< Include sarzs=1
4 Include sarzs=2
il ® Include sarzs=3
° B Include sarzs=4
86 o * Include sarzs=5
A Include sarzs=6
84 i + Include sarzs=7
# =
-2 0 2 4 6 8 10 12 14 Include sarzg_s
O Include sarzs=9
ho o Other
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formdlis elemzés: egyeneseket illesztiink

Univariate Tests of Significance forkonc (nemlin_stab.sta)
Sigma-restricted parameterization
Effective hypothesis decomposition; Std. Error of Estimate: 2.185474

SS Degr. of MS F p
Effect Freedom
Intercept | 144541.91 1 144541.91 30262.32 0.000000
sarzs 6.33 8 0.79 0.17 0.993763
ho 143.16 1 143.16 29.97/ 0.000009
sarzs*ho 71.98 8 9.00 1.88 0.104539
Error 128.96 27 4.78
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ho vs. konc, Resids
(Analysis sample)
4
s nem illeszthettnk
8 o
2 ° 3 egyeneseket
o o g
%) 1 o )
E 0 & ¢
é 3 8 o
-1 o o
e g 8
-2 8
8
-3
-4
-2 0 2 4 6 8 10 12 14

ho

megfeleb transzformacio lehet: a honapok logaritmusa
fuggvényében abrazoljuk a mért koncentraciokat,

de In(0)

In(ho+0.05)
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Scatterplot of konc against Inho
nemlin_stab.sta 4v45c

102 T T T T T T
100 $ 8
A
= +
o + *
98 s o 1
2 ; . "
96 . ]
: i
. *
94 - v O 0o
o * °
5 A A
] A
92 §
A
9 ° 1
¢ Include sarzs=1
4 Include sarzs=2
88 1 ® Include sarzs=3
N B |nclude sarzs=4
86 e | * Include sarzs=5
A Include sarzs=6
a4 i i i + Include sarzs=7
* Include sarzs=8
4 3 2 1 0 1 2 3 o Include sarzs=9
Inho O Other
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Univariate Tests of Significance forkonc (nemlin_stab.sta)
Sigma-restricted parameterization
Effective hypothesis decomposition; Std. Error of Estimate: 2.23287¢
58 Degr. of MS F p
Effect Freedom
Intercept 346717.72 1 346717.73 69541.71 0.00000C
sarzs 92.59 8 11.57 2.32 0.048624
Inho 178.63 1 178.63 35.83/ 0.000002
sarzs*Inho 30.86 8 3.86 0.77 0.62893€
Error 134.62 27 4.99

az egyenesek meredeksegenek kulotbgége nem szignifikans (p=0.6

az egyes sarzsokra parhuzamosaknak tekinthetjigy@neseket
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Raw Residuals

Predicted vs. Residual Values
Dependent variable: konc
(Analysis sample)

o (<39

o 000
[}

86 88

92 94 96 98 100

Predicted Values

102

104

a reziduumok menete nem mond ellent a linearitasnak
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Normal Prob. Plot; Raw Residuals
Dependent variable: konc
(Analysis sample)

.99
.95

[

E

[

> 75

]

£

S .55

z

g 35

(%3

g

5 15
.05
.01

-3.0
-4 -3 -2 -1 0 1 2 3 4 5 6
Residual
a normalitds nem teljesen megnyugtato
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A parhuzamos egyenesek kdzos tengelymetszeténsdaldda

Univariate Tests of Significance forkonc (nemlin_stab.sta)
Sigma-restricted parameterization
Effective hypothesis decomposition; Std. Error of Estimate: 2.174338
SS Degr. of MS F p

Effect Freedom

Intercept | 346717.73 1 346717.72 73336.78 0.000000

Inho 178.63 1 178.63 37.78| 0.000000

sarzs 154.58 8 19.32 4.09| 0.001606

Error 165.47 35 4.73

a tengelymetszetek szignifikansan kilénb6znek
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konc

a legrosszabb (3. szamu) sarzsra

Scatterplot of aktiv against Inho
nemlin_stab.sta

Include condition: sarzs=3
konc = 92.9149-1.8248*x; 0.9 Conf.Int.

80
Inho
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a parhuzamos egyenesek konfidencia-savjkets, mint az
egyenkéntieké (a rezidualis széras szabadsagi fakgobh)

a 3. sarzshoz szamolunk konfidencia-savot, de faltédsa az
egyenesek egyduttes illesztésekor kapott reziduabisisnégyzetet

Scatterplot of multiple variables against Inho
Include condition: sarzs=3

96
e 18 hénapnal
o In(ho+0. 05)=2.893
93
92
91
90
89
88
87
86,4 -3 2 1 0 1 2 3 4 o koncPREL
Inho o, koneLCLL
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a mért koncentracié-pontok kézil néhany az alsé konfidesav

alatt van

baj ez?

Scatterplot of multiple variables against Inho

o Include condition: sarzs=3

96

94

92

90

88

86

84

O konc
4 8 2 1 ° 1 2 8 “B. koncPREL
Inho e koncLCL1
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az eredeti id-skalaval abrazolva

Scatterplot of multiple variables against ho

Include condition: sarzs=3

96
95
94
93
92
91
90
89
88
87
86 : : :
2 0 2 4 6 8 10 12 14 16 18 20 22 “a_koncPREL
ho O koncLCL1
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Nemlineéris fuggvény
5. példa: Bomlastermék koncentracioja
bomlastermek.sta
1 2 8
sarzs honap boml
1 5 0 0
2 5 3 0.17
3 5 6 0.23
4 5 9 0.25
5 6 0 0
6 6 3 0.15
7 6 6 0.21
8 6 9 0.24
9 7 0 0
10 7 3 0.12
11 7 6 0.19
12| 7 9 0.21
Stabilitasvizsgalat 85




Specify Multiple Subset

Graphs>Scatterplots
Subset1
: Mark selected subsets (alul)
sarze=h Scatterplot of bomlagainst honap
bomlastermek.sta 3v*12c
0.26
Subset 2 o
0.24 D
. o
Include If: hd 0.22
e a °
sarzs=h 0.20
= .
0.18
©
Subset 3 0.16
JAY
Include If: A4 0.14
sarzs=7 E 0.12 .
0.10
0.08
0.06
Quick | Advanced | Appearancs | Categorized | Options 1 Options 2 |
Graph layout
&Y fuds positon I ©  Include sarzs=5
Fitted function 0 2 4 6 8 10 & Include sarzs=6
R ® Include sarzs=7
Slisplay Tit expression. |/n ke honap O Other
Folynomiai order
Logarithmic base maSOdfOkU
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A ¢ H Scatterplot of bomlagainst hona
Masodfoku polinon oo it
omlastermek.sta 3v*12c

2D Scatterplots 026 boml=0.0022+0.0563*x-0.0034*x"2; 0.9 Conf.Int.

Quick | Advanced | Appearance | Categorized | Opt 0.24
0.22
E Yanables: l: = honap
Elv bl 020
0.18
0.16
Eit
0.14
att =
5 o012
| Linear 8 -
T 010
Frequency | Logaiithmic 0.08
Bubble |/ Exponential 0.06
Quantile [, Distance \Weighted L 004
Varonoi | Meg Expon weightec ’
L= Spline 002
", Lowess 0.00
\_7 e Include sarzs=5
0.02 8
2 o 5 4 5 s 1 S Include sarzs=6
e Include sarzs=7

honap o Other

Nem j6, nem monoton (ez a polinom tulajdonsaga).
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Hatvany-fuggvény
Statistics>Advanced Linear/Nonlinear Models>NonlinEatimation

[ Nonlinear Estimation: bomlastermek.sta |E|E| rg‘ m Estimated functial

Quick oK

Estimated function:

@ User-specified regression, least squares Cancel bom|=a*h0napAH
[ L ified re i m lozs function 5
[®] Options -
Quick Logit regression
: Quick Probit regression = OpenData | s Fareting:

: Exponential growth regression

7 Fiecewise inear reqression RSt

‘You can also use the GLE module to analyze continuous, binomial, or multi-nomial

dependent wariables (e.q.. for Logit or Probit regression). B User-Specified Regression, Custom Loss: bomlasti [
Duick 0K
[%]_Function to be estimated & loss function
Function: boml=a*honap™b
Loss: [OBS-PREDf*2
MO deletion
@ Casewise
O Mean
substitution
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Model: boml=a*honap”b (bomlastermek.sta)

Dep. var: boml Loss: (OBS-PRED)**2

Final loss: .003286812 R=.98376 Variance explained: 96.778%
N=12 a | b

@ Model Estimation: bomlastermek.sta

Model is: boml=a*honap®h

MNunber of parameters to be estimated: =
Estimate | 0.095779 0.414298 Loss function: {(0OBZ-PRED)**Z
Std.Err. | 0.013931 0.076477 Dependent variable: boml

t(10) 6.875286| 5.417290

Independent wariables: honap

p-value | 0.000043 0.000294

Mizsing data are casewise deleted
Model: boml=a*honap”b

y=(.09577941238091)*x(.41429753098315) Huwber of walid cases: 1z
0.26
0
0.24 S ! !
0.22 | Quick  Advanced  Review
o o
0.20 A .
018 o Estimation method: | Quasi-Mewton
’ o
0.16 Asymptotic standard emors
0.14
o c B
0.10 b axirmum number of jrerations:
0.08 -
LConvergence criterion: oo
006 Lo [
0.04 %] Startvalues | 100000 for all parameters
0.02 = — -
0.00 o ] Initial step sizes: | 500000 far all parameters
-0.02
-2 0 2 4 6 8 10

honap

Ez j6, a meglé§ mérési pontokra, de az extrapolalhatésaga kérdéges.
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Predicted versus Residual Values

0.04
0.03 o
0.02 o
« o
§ oo 5
e o
F 000[ © o
3
§ -0.01 Normal Probability Plot of Residuals
2.0
-0.02
15
-0.03
-0.04 10
-0.02 0.02 0.06 0.10 0.14 4
0.00 0.04 0.08 0.12 %
S o5
Predicted Value: 3
E
E 0.0
e
2
2 -05
o
X
i
-1.0
-15
-2.0
-0.04 -0.03 -0.02 -0.01 0.00 0.01 0.02 0.03 0.04
Residuals
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. . 7 .
Logaritmus-figgvény Fit
off
Scatterplot of bomlagainst honap IL Linear
bomlastermek.sta 3v*12c .
boml= 0.0606+0.1847*10g10(X) A, Polnomial
0.40
| Exponential
0.35 . .
Il Distance "Weighted LS
0.30 IL Meg Expon Weighted LS
|.=' Spline
025 |, Lowess
E 0.20
0.15
L]
0.10
0.05
000 ® o Include sarzs=5
o 2 4 6 8 10 12 14 16 18 po_ ncludesarzs=s

e Include sarzs=7
honap o Other

Ez is jO, extrapolalhatosagi szempaifitbzimpatikusabb, csak a 0
idépontban nem értékelhieki (IN0=-co).
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Javitott logaritmus-figgvény

[ Estimated function and lo

E stimated function:

barnl=a+b*laghonap-+0.05)

| User-Specified Regression, Custom Loss: bol

Quick

[ 0n_-;,i Function to be estimated & lozs function ]

Function: boml=a+b*loglhonap+0.05]
Loss: [OBS-PRED]™2

Models/Nonlinear Estimation

Statistics>Advanced Linear/Nonline 500000 for al parameters
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& Model Estimation: bomlastermek.sta

Model is: boml=atb*logihonap+0.0E8)
Number of parameters to be estimated: Z
Loss function: {(OES-PRED)**Z

Dependent wvariable: boml

Independent wariables: honap

Missing data are casewise deleted

Number of walid cases: 1z

Quick  Advanced Review

Estimation method: | Quasi-Newton w

Azymptotic standard emors
Eta for finite diff. appro=., 1.E- |8 @
b asimumm number of jterations: A0 EI

Convergence criterion: oo EI

?1-}1 Start values: 100000 for all parameters

Dep. var: boml Loss: (OBS-PRED)**2

Model: boml=a+b*log(honap+0.05) (bomlastermek.sta)

Final loss: .005775438 R=.97128 Variance explained: 94.339%

N=12 a | b

Estimate 0.12458| 0.04321
Std.Err. 0.00716| 0.00335
t(10) 17.39596 | 12.90943
p-value 0.00000  0.06Q00

Guick™~Advanced FResiduals | Fewview

Summary: Parameters & standard emors ] E-value e 05 EI

ighlighting:

[ 5cale M5-gmar to 1

LCiovars & correlations of parameters Fitted 2D function & obzerved va@}x

N

Covariance Matrix of Parameter Estimates (bomlastermek.stal
Parameter a \ b
a 0.000051 -0.00000€
b -0.00000€ 0.000011
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Model: boml=a+b*log(honap+0.05)
y=(.12457523368653)+(.04320877748911)*l0g(x+0.05)

0.28
0.26
0.24 o
0.22
0.20
0.18
0.16
0.14
0.12 o
0.10
0.08
0.06
0.04
0.02
0.00
-0.02
-0.04

honap
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Konfidencia-sav Y 1S <Y < Y+ t2S

linearisnal: S, =S 1+%
. y n z Xi - 2

itt: Y =a+blIn(x+ 005)

Var (\?) kell

Hibaterjedési torvény
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Kitéré: hibaterjedési térvény
F= F(xl, Xy Xgy one ,xr)
Taylor-sorba fejtve az F° = F(xf,xg,...,xro) igazi érték korul:

F=F°+(%J(xl—xf)+(§2j(xz—x§)+ +(§J(xr—xr°)+

T

+%(0;5<1|2: ](Xl_xf)z +--'+(;(;2](x1—xf)(x2 —x§)+

A 5, =x-X]  hibak kicsinyek, négyzeteik kiléndsen
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17 17 74 17
o :(d—zjq+(d—)2j@ +(d—)l(:3j@+ +(0_,)|(:Ja;
Var (0, ) = (02 )= Elo? )+ E(67 )+ E(0,,6,)+ (T

E(sz): El(dj _O)ZJ: oy

ellg, ~o)e. ~0) = covlgi )

2 2
ot = I9F o2 + oF o2+ IF | 9F Cov(x,, X, )+ [
X ol dX%, 2\ adx )\ %,
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Y =a+blIn(x+ 005)

A): Al

AN 2 ~ ~
Var(Y oY 2+20—Y oY

— | gl+|—| g — o,
da) * |ab) °® da | ob | ®

Var (Y )= Var (a)+[In(x+ 005)JVar (b) + 2In(x+ 005)Cov(a,b)

2 =& +[In(x+ 005)s? +2In(x + 005)s,,
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Model: boml=a+b*log(honap+0.05) (bomlastermek.sta)

Dep. var: boml Loss: (OBS-PRED)**2

Final loss: .005775438 R=.97128 Variance explained: 94.339%
N=12 a | b

Estimate | 0.12458 0.04321

Std.Err. 0.00716 0.00335

t(10) 17.39596 | 12.90943

p-value 0.00000 0.00000

Sar S

Sab

/

Covariance Matrix of Parameter Estimates (bomlastermek.stal
Parameter a \ b

a 0.000051 -0.00000€
b -0.00000€ 0.000011
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sarzs

honap

boml

N Ald WINEP

NNN~NOo oo o oo o

© OO WO Vo WwWwo WwWwo wo

0.17
0.23
0.25

0.15
0.21
0.24

0.12
0.19
0.21

File>Open: Konfint4b.svb

1 2 3
sarzs X Yy
1 5 0 0
2 5 3 0.17
3 5 6 0.23
4 5 9 0.25
5 6 0 0
6 6 3 0.15
7 6 6 0.21
8 6 9 0.24
9 7 0 0
10 7 3 0.12
11 7 6 0.19
12 7 9 0.21
13 12
14 18
15 24

Selection condition

alfa=

[0
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1 2 3 4 5 6
sarzs X y becsult | y also y felso y
1 5 0 -0.00487 -0.02968 0.019947 0
2 5 3 0.172759 0.159695 0.185824 0.17
3 5 6 0.202354 0.187609 0.217099 0.23
4 5 9 0.219754 0.203598 0.23591 0.25
5 6 0 -0.00487 -0.02968 0.019947 0
6 6 3 0.172759 0.159695 0.185824 0.15
7 6 6 0.202354 0.187609 0.217099 0.21
8 6 9 0.219754 0.203598 0.23591 0.24
9 7 0 -0.00487 -0.02968 0.019947 0
10 7 3 0.172759 0.159695 0.185824 0.12
11 7 6 0.202354 0.187609 0.217099 0.19
12 7 9 0.219754 0.203598 0.23591 0.21
13 12 0.232125 0.214825 0.249424
14 18 0.249585 0.230518 0.268651
15 24 0.261985 0.241578 0.282392
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2D Scatterplots

‘ Quick I.é.dvancec! _:___Appearance'_

‘ EX: B
E__Y:

Multiple

Fit typpe:

‘ [ Linear

101

y becsult-y felzo

Fegression

& 0
(D) Confide

(D Predicti




Scatterplot of multiple variables against x
bomlastermek.sta 6v*15¢

0.30
0.25
3
5 o
0.20 o o .
° o Graph Options
o
[m]
0.15 [=)- Graph
windows PBlat: | 1: y becsult | B Add new fit
Layouk
010 Titles/Text Fit type:
= Plot .
005 General Fitting data
: Scatterplot X
Scale:
o Point Labels
0.00 & Fitting Range: b I:l Max: I:l
Ellipse
[u) Reqression Bands Line
-0.05 O ybecsult
-2 0 2 4 6 8 10 12 14 16 18 20 22 24 26
O yalso
X < yfelso
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Scatterplot of multiple variables against x
bomlastermek.sta 6v*15¢
y becsult = Distance Weighted Least Squares
0.30
0.25
0.20
0.15
0.10
0.05
0.00
u]
-0.05
2 0 2 4 6 8 10 12 1a 16 18 20 22 24 26 > Ybeosut
O yalso
X < yfelso
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Scatterplot of multiple variables against x

Function = 0.12458+0.04321*Log(x+0.05)
Function = 0.12458+0.04321*Log(x+0.05)

+2.228*sqrt(0.00005128+(Log(x+0.05))"2*0.00001120-Log(x+0.05)*0.00000594)

Function = 0.12458+0.04321*Log(x+0.05)

0.35

0.25

0.20 |

0.15 f

0.10 |

-2.228*sqrt(0.00005128+(Log(x+0.05))2*0.00001120-Log(x+0.05)*0.00000594)
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o yClu
o yCIL
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Becsulhetiink-e valamit &e?

K. Komka, S. Kemény: Effect of the uncertainty loé tstability data on the
shelf life estimation of pharmaceutical productsti@dica Polytechnica, Ser.
Chem. Eng. 481-52 (2004)

Analytical measurements Thedetermined The elementary
variance component variance component
2 2
. . Obaich O atch
Content uniformity test = —=
a-taua aheterogeneity
2 2
. . Jday Uday
Validation P g
Precision study lab lab
2 2
Jrepeatability a-error
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2 — 2 2 . .
Oaples = a—heterogene'ty * Ogror Content Unlformlty

Jrzqoeatabiliw = o-r?eterogene'ty / p+ J:rror Repeatablllty StUdy

a—r?eterogene'ty = (o-tiblet - a—rzqoeatability ) / (1_ 1/ p)

2
2 Uheter ogeneity

2 _ p 2 2 2
g = * Opaten T Ogay T Ol
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Matrixing: egy-egy vizsgalati iibontban csupan a vizsgalandoé
mintak egy reszet teszteljuk

A modszer alkalmazasanak fontos kdvetelménye, hagy
egymast kovétvizsgalati pontokban a mintaknak mindig
kilénb6d részleteit vizsgéljuk meg.

A modszer azon a feltételezésen alapul, hogy ait mtdpontban
vizsgalt mintak stabilitasi tulajdonsagai az 6ssneda stabilitasi
tulajdonsagait reprezentaljak.

Bracketing: minden vizsgalatidgontban csupan a szélértéki
(pl. hatasafsség vagy csomagolasi méd szerinti) mintakat
teszteljuk.

A mobdszer azon a feltételezésen alapul, hogy abgdg” mintak
stabilitasat jellemi tulajdonsag-értékek a ,széfamintak
stabilitasat jellemi tulajdonsag-értékek kdzott helyezkednek el.
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Pl. a teljes terv

3 hataseisségre,

hatasefsségenként 3 sarzsra,

kétféle (pl. 90 és 100 tabletta/ flakon) csomagalas

12 idspontban

0sszesen 12*3*3*2=216 analizis

minden vizsgalando korilmény-rendszerrénfiérséklet és
nedvességtartalom).

Ez csokkenthéta bracketing és matrixing médszereével.
Fontos tudni, hogy az analizisek szamanak csokkéweéa lejarati

id6 kijeloléséhez hasznalando konfidenciasav szélessgdelat
rovidebb lejarati idt kapunk.
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Csak bracketing: a kozépbatasefsséd tablettak vizsgalatat
mell6zhetjuk.
igy a 216 helyett 144 analizist iruni el

Csak matrixing:

azl,2.,3.,6.9,18., 24., 48. honapoknal §pamtban)
végzend teljes terv (8*3*3*2=144 analizis) fele (72 anadigi
a0., 12., 36. és 60. hdnapnal minden (4*3*3*2=a123lizist
eldirva,

bevonva a kétféle csomagolast, haromféle haiaséget,
(6sszesen 72+72=144 analizis) .

Ennél a tervnél a csokkentés egyenletesen os#Aik sz
(kiegyensulyozott terv).
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Matrixing: nem minden iébontban végzik el az 6sszes mérést
teljes: 0, 12, 36, 60, részleges: 1, 2, 3, 6, 924348

month
Batch [tabl./bottle| 0 1] 2 3 6 9 [ 12 [ 18] 2436 ] 48 [ 60
Al 90 + + - - + - + + + + - +
A2 90 + - + + - + + + + +
A3 90 + + + + + + + +
B1 90 + - + + - + + - - + + +
B2 90 + - + + - + + - - + + +
B3 90 + + - - + - + + + + - +
C1l 90 + - + + - + + - - + + +
C2 90 + + - - + - + + + + - +
C3 90 + - + + - + + - - + + +
Al 100 + - + + - + + - - + + +
A2 100 + + - - + - + + + + - +
A3 100 + + - - + - + + + + - +
B1 100 + + - - + - + + + + - +
B2 100 + + - - + - + + + + - +
B3 100 + - + + - + + - - + + +
C1l 100 + + - - + - + + + + - +
C2 100 + - + + - + + - - + + +
C3 100 + + - - + - + + + + - +
+ van analizis, - nincs analizis
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Valtozatok:
az analizisek szdma
azokban az ifpbontok-| azokban az isbontok-| dsszes
ban, ahol nem hajtunkban, ahol mindenkisérlet-
végre minden kisérletel kisérletet végrehajtunkszam
teljes terv a 0., 12{,72 72 144
36. és 60. hénapnal
teljes terv a 0., 36.54 54 108
és 60. hénapnal, 1/3
terv
telies terv a 0., 3¢.108 54 162
és 60. hénapnal, 243
terv
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A bracketing és matrixing kombinacioja

Csak a két széshataseafsségre végeznének vizsgalatokat
(bracketing), de ezeknél sem mindeépidntban, hanem rész-
faktortervként (matrixing).

A 12. honapot nem tintettem ki, de a 0., 36. és60apot igen
(vagyis 9 idpontban lennének nem-teljes elemzések).
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Batch | tabl./bottle | O 1 2 3 6 9 12 | 18 | 24 | 36 | 48 | 60
Al 920 + + - - - - + - + + - +
A2 90 + - - + - + - + - + - +
A3 90 + - + - + - - - - + + +
C1 90 + - + + + + - + - + + +
Cc2 920 + + + - + - + - + + + +
C3 90 + + - + - + + + + + - +
Al 100 + - + + + + - + - + + +
A2 100 + + + - + - + - + + + +
A3 100 + + - + - + + + + + - +
C1 100 + + - - - - + - + + - +
Cc2 100 + - - + - + - + - + - +
C3 100 + - + - + - - - - + + +

+ van analizis, - nincs analizis

Stabilitasvizsgalat 113




Koncepcionalis probléma

Az adatok szamanak novelésével a konf. sékidz
Han— o, 0 a szélessége

Alsé konf. hatansre:
La :,80+,[>’[—zaa/\/ﬁ
L £-E()

O

P(zzmj: P(zz :/E’j han— o P(z=0)=05

g n

A tablettak 50%-a lenne a hatar folott.
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.Az 0sszes jogbeli sarzsra...”> a sarzs véletlen faktor

A Guideline ,igazi” figgvényt feltételez, ennek a
konfidencia-savjat szamoljuk ki.

A valésagban inhomogenitas van, emiatt a tablettak

zomebl (pl. 99%-ardl) lenne értelme beszétni
tolerancia-tartomany.
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